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End User License Agreement 
This is a legal agreement between you, the end user, and Gaumard

®
 Scientific Company, Inc. 

(“Gaumard”). This software is protected by copyright laws and remains the sole property of 
Gaumard. By installing the UNI (the "Software") media, you agree to be bound by the terms of this 
agreement. If you do not agree to the terms of this agreement, promptly return the uninstalled 
media and accompanying items to Gaumard at the address indicated below. 

1. Grant of License. Gaumard hereby grants to you (an individual or institution) the right to install 

and activate the Software on one computer for use with one Interactive patient simulator system. 
The software may also be installed on any number of other computers at the same institution so 
that students may access the learning resources. One copy of the software may be made for 
backup purposes. You may not network this Software, or allow multiple users unless you 
purchased a multi-user workstation license. Sharing this Software with other individuals or allowing 
other individuals to view the contents of this Software is in violation of this license. 

2. Copyright. The Software is owned by Gaumard and protected by United States copyright laws 

and international treaty provisions. Therefore, you must treat this Software like any other 
copyrighted material. You may not make this Software or copies thereof available in any manner or 
form or use, copy or transfer the Software, in whole or in part, except as provided herein. 

3. Other Restrictions. You may not rent or lease this Software to any other party. You may not alter, 

merge, modify, adapt, reverse engineer, decompile or disassemble the software, or disclose the 
contents of this Software to any other party. 

4. Electronic Transmission of Software. If you received the Software by electronic transmission or 

by Internet delivery, by installation of the Software, you acknowledge that you have read and 
understand this license agreement and agree to be bound by its terms and conditions. 

5. Term of Agreement. The term of this Agreement and the license granted to you pursuant hereto 

shall commence upon installation of this Software. This Agreement and the license granted herein 
may otherwise be terminated by Gaumard in the event that you are in breach of any provision of 
this Agreement. In the event of termination, you agree to immediately return this Software, 
accompanying items, and any copies thereof to Gaumard. 

6. LIMITED WARRANTY 

(A) THE CD-ROM MEDIA (THE "MEDIA") WHICH CONTAINS THIS SOFTWARE IS 

WARRANTED, FOR A PERIOD OF 30 DAYS FROM THE DATE OF PURCHASE, TO BE FREE 

FROM DEFECTS IN MATERIAL AND WORKMANSHIP. ELECTRONIC TRANSMISSION IS 

WARRANTED TO BE FREE FROM DEFECTS AT THE MOMENT OF TRANSMISSION. YOUR 

SOLE AND EXCLUSIVE REMEDY, AND GAUMARD'S SOLE LIABILITY, IS TO REPLACE THE 

DEFECTIVE MEDIA OR TO REPEAT THE ELECTRONIC TRANSMISSION PROVIDED THAT 

YOU NOTIFY GAUMARD IN WRITING OF SUCH DEFECT OR DEFECTIVE TRANSMISSION 

AND RETURN THE DEFECTIVE MEDIA, IF ANY, DURING THE 30-DAY WARRANTY PERIOD. 
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(B) EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED IN PARAGRAPH (A), THE 

SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED ON AN "AS IS" 

BASIS, WITHOUT ANY WARRANTIES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO, ANY 

IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR 

PURPOSE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY GAUMARD, ITS 

DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN 

ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY 

SUCH INFORMATION OR ADVICE. GAUMARD DOES NOT WARRANT, GUARANTEE, OR 

MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF USE, OF THE 

SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, 

RELIABILITY, CURRENTNESS, OR OTHERWISE, AND THE ENTIRE RISK AS TO THE 

RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE 

SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU AND NOT GAUMARD OR ITS 

DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL 

NECESSARY SERVICING, REPAIR OR CORRECTION OTHER THAN EXPRESSLY 

DESCRIBED ABOVE. 

(C) NEITHER GAUMARD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 

PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, 

INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS 

OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 

AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT OR 

RELATED TO THIS AGREEMENT EVEN IF GAUMARD HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. GAUMARD SHALL NOT BE LIABLE TO YOU FOR ANY 

INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOST PROFITS 

ARISING OUT OF OR RELATED TO THIS AGREEMENT OR YOUR USE OF THE SOFTWARE 

AND/OR THE RELATED DOCUMENTATION, EVEN IF GAUMARD HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL GAUMARD'S LIABILITY HERE 

UNDER, IF ANY, EXCEED THE PURCHASE PRICE PAID BY YOU FOR THE SOFTWARE. 

ALL RIGHTS NOT EXPRESSLY GRANTED IN THIS LICENSE AGREEMENT ARE RESERVED 

BY GAUMARD. 

ACKNOWLEDGMENT 

BY INSTALLATION OF THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ AND 
UNDERSTAND THE FOREGOING AND THAT YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND 
EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL 
PROPOSED OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER 
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE LICENSE DESCRIBED 
HEREIN. 
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Care and Cautions 
The Gaumard warranty does not cover 
damage caused by misuse. It is critical to 
understand and comply with the following 
guidelines to prevent injury to the user and 
damage to the simulator. 

PROCEDURES 

Do not attempt to intubate without lubricating 
the airway adjunct with silicone lubricant 
(provided). Intubating the simulator without 
lubrication may result in damage to the 
airway. 

Mouth to mouth resuscitation without a 
barrier device is not recommended, as it will 
contaminate the airway. Treat CHLOE with 
the same precautions used with a real 
patient. 

The lubricants and other accessories 
provided are for use with the accompanying 
patient simulator only.  The lubricants and 
other accessories are not suitable for 
human use or medical 
treatment/diagnosis and should never be 
used for such purposes. 

IV ARM 

Vein tubes contain latex, which may 
cause allergic reactions. Users 
allergic or sensitive to latex should 
avoid contact. Discontinue use of this 
product and seek medical attention if 
an allergic reaction occurs. 

Use only simulated blood provided by 
Gaumard. Any other simulated blood brand 
containing sugar or any additive may cause 
blockage and/or interruption of the 
vasculature system. 

The use of needles larger than 22 gauge will 
reduce the lifetime of the lower arms' skin 
and veins. 

When the arm veins require replacement, 
contact Gaumard to arrange for a lower arm 
exchange. For a small fee, we will deliver 
reconditioned and warrantied lower arm 
assemblies to your facility. Upon receiving 
the replacement arms, use the same box 
and the enclosed shipping label to return the 
old arms to Gaumard. For international and 
express service, additional fees may be 
charged. Refer to the Consumables and 
Replacement Parts section of this guide, and 
contact customer service for more 
information. 

STORAGE 

Store CHLOE in a cool, dry place; extended 
storage above 85 degrees Fahrenheit (29 
Celsius) will cause the simulator to soften 
and slowly warp. It is acceptable to operate 
CHLOE at an ambient temperature of 95 
degrees Fahrenheit (35 Celsius). 

Do not store the simulator with a discharged 
battery. Re-charge the backup battery at the 
end of every simulation session. In addition, 
recharge the battery at least once every 30 
days even if the simulator is not in use; 
otherwise, permanent loss of capacity might 
occur because of self-discharge.  

Ballpoint pens, ink or newsprint, and markers 
permanently stain the skin. 

WARNING: 

To avoid damage to the simulator, 
please store and ship it in the clear 
poly bag provided. 

CLEANING 

Clean CHLOE with a cloth dampened with 
diluted liquid dishwashing soap. If medical 
adhesives remain on the skin, clean with 
alcohol wipes.  

Do not use citric acid cleaners anywhere on 
the simulator. Doing so will cause pitting of 
the various materials comprising your 
simulator. 

CHLOE is "splash-proof" but not waterproof. 
Do not submerge or allow water to enter the 
interior of the simulator. Do not expose the 
tablet computer to water or excessive dust. 

Always purge and drain the arterial and 
vein reservoirs at the end of the 
simulation session. Doing so will prevent 
molding or clogging. 

SURGICAL 

Use only simulated blood provided by 
Gaumard. Any other simulated blood brand 
containing sugar or any additive may cause 
blockage and/or interruption of the 
vasculature system. 

Always clean and purge the reservoirs at 
the end of simulation. Do not store the 
simulator with fluid in the reservoirs or 
the internal arterial and venous 
vasculatures. For more information, go to 
page 34. 
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Do not allow simulated blood to puddle 
beneath the simulator or to reach the lower 
back. 

Do not allow simulated blood to puddle 
inside the abdominal cavity. 

Remove the uterine assembly and clean 
thoroughly using diluted soap and water to 
prevent staining or molding. 

Always lubricate the surgical tools prior to 
insertion. Doing so will prevent damage to 
the laparoscopy ports. 

ASSEMBLIES 

Do not use electrosurgical or cauterization 
tools on any of the uterine assemblies or 
abdominal covers. 

Always handle the assemblies with clean 
hands. 

Clean the assemblies with diluted soap and 
water. Do not clean with alcohol or 
aggressive solvents. 

Do not pack any sharp objects with the 
assemblies. 

Prevent items from resting or pressing 
against the assemblies as indentations will 
form on the pressure points.  

Apply talcum powder to the assemblies to 
reduce tackiness. 

CLEANING THE 
ELECTROCARDIOGRAM SITES 

Always keep the electrocardiogram sites 
clean. 

Always clean the conductive sites at the end 
of simulation using a gentle degreasing 
cleanser or soap and water. 

Do not leave ECG electrodes attached for 
use the next day. 

Never attempt to service or modify any of the 
electrocardiogram sites. Discontinue use if 
any wires are exposed with damaged 
insulation. 

If dark traces appear on the 
electrocardiogram sites, use a pencil eraser 
to remove the traces and then clean with 
alcohol or soap and water.  

Do not scratch the conductive patches with 
abrasive objects; doing so will cause 
irreversible damage to the conductive sites. 

Specifications 
Height: 5 feet, 9 inches (175 cm) 

Weight: 65 lbs. (29 kg) 

Power input: 100-240 VAC, 

50/60 Hz, 2 A 

Power output: 13 VDC, 9.2 A 

Capacity of hemorrhage reservoirs: 

Arterial: 750 ml 

Venous: 750 ml 

Simulator connectivity:  
Wired (RJ45) Gaumard USB communication 
module 

Environmental 

Operating temperature: 45F to 95F (7C to 

35C) 

Storage:  55F to 85F (13C to 29C) 
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Getting Started 
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Terminology 
Facilitator - the person conducting the 

simulation; an instructor or lab staff member. 

UNI - is the software application, used to 

control the simulator and evaluate care 
providers. 

Palette - a collection of Palette Items. Each 

profile has its own palette. 

Palette Item - Any full or partial set of 

physiological parameters that have been 
grouped and saved together under a single 
name. 

Profile - a unique CHLOE software 

configuration, including custom Palette, 
Scenarios, and options. Each Profile acts as 
a separate program, in that changes made to 
one profile have no effect on the others. 

Provider - a person participating in the 

simulation as a healthcare provider. 

Scenario - a saved sequence of 

physiological states, like a "playlist." 
Scenarios provide a level of automation that 
unburdens the facilitator and allows 
standardized presentation of symptoms. 

Scenario Item - a Palette Item that is part of 

a scenario. Scenario Items may also 
represent a fixed delay period ("Wait") or a 
pause ("Wait Indefinitely"). 

Stylus - a special pointing device for the 

tablet computer. The stylus is the fastest and 
easiest means of controlling the CHLOE 
software. See the Equipment Set-up section 
of this guide for more information on working 
with the stylus. 
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Overview 
Surgical Chloe can be used to address 
competencies in six areas including: patient 
care, medical knowledge, practice based 
knowledge and improvement, systems 
based practice, communication, and 
professionalism. 

GENERAL 

 Powered from an internal rechargeable 
battery or wall outlet 

 Simulator receives commands from a 
wired Laptop (15 foot Ethernet cable 
included) 

 Use preprogrammed scenarios, modify 
them or create your own quickly and 
easily 

 Remains fully functional even while in 
transit 

 Workbook of ten (10) advanced 
scenarios and example surgical 
checklists 

 Training Video 

SURGICAL COMPONENTS 

Uterine Assembly 1: Normal Uterus with 

ectopic pregnancy and uterine bleeding. 

Simulates ruptured Ectopic pregnancy with 
bleeding, severe vaginal bleeding from 
uterus, and includes bladder. 

Uterine Assembly 2: Enlarged Uterus with 

dermoid cyst on one side and ectopic 
pregnancy on the other. Simulates ruptured 
ectopic pregnancy with bleeding; also 
includes realistic dermoid and bladder. 

Uterine Assembly 3: Enlarged uterus with 

embedded fibroids, endometrioma on one 
side, and simple cyst on the other. Simulates 
embedded bleeding fibroids; also includes 
realistic simple cyst, endometrioma, and 
bladder. 

ABDOMINAL WALL INSERT 

 Use your instruments for incision, 
dissection, and suturing  

 Can be used at least four (4) times  

 Multi-layer design replicates the skin, 
subcutaneous, fascia, muscle, and 
peritoneum  

 Incorporates bleeding  

 Can be used to perform either 
Pfannenstiel or vertical incision  

 Can be used to place laparoscopic 
trocars 

LAPAROSCOPY ABDOMINAL 
WALL 

 Includes 8 access ports on left, right, 
and midline of abdominal wall 

BOWEL OVERLAY 

 Includes insert that can be placed over 
uterine assembly for added realism 

PREPROGRAMMED SCENARIOS 
BY MARTIN E. OLSEN, MD 

 Ruptured ectopic pregnancy 

 Pelvic mass in pregnancy 

 Septic abortion 

 Bleeding disorder Von Willebrand’s 
disease 

 Post-operative hemorrhage after 
conization of the cervix 

 Fire in the OR 

 Malignant hyperthermia during surgery 

 Cardiac arrest in the OR 

 Anaphylaxis and Hypoxia in the OR 

AIRWAY 

 Multiple upper airway sounds 
synchronized with breathing 

 Bag-Valve-Mask Ventilation 

 Placement of conventional airway 
adjuncts 

BREATHING 

 Control rate and depth of respiration 

 Chest rise and lung sounds are 
synchronized with selectable breathing 
patterns 

 Simulated spontaneous breathing 

 Normal and abnormal breath sounds 
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CARDIAC 

 Conductive skin regions allow for ECG 
monitoring with real equipment 

 Heart sounds may be auscultated and 
are synchronized with ECG 

CIRCULATION 

 Measure blood pressure by palpation or 
auscultation  

 Use real BP cuff rather than a “virtual” 
cuff to measure blood pressure  

 Korotkoff sounds audible between 
systolic and diastolic pressures  

 Oxygen saturation detected using real 
monitors rather than a “virtual” value  

 Pulse sites synchronized with BP and 
heart rate  

 Bilateral IV arms with fill/drain sites Sub-
Q and IM injection sites 

 ECG monitoring using real devices  

 Multiple heart sounds, rates and 
intensities 

 Virtual ECG rhythms are generated in 
real time  

 Ovarian and Uterine arteries and veins, 
with bleeding functionality  

 During application of scenarios, vital 
signs reflect physiologic changes that 
occur with hemorrhage 

NEURAL RESPONSES 

 Open and close the eyes manually 

SPEECH 

 Wireless streaming audio & prerecorded 
responses 

 Create and store vocal responses in any 
language 

USER INTERFACE 

 Sensors track participants actions 

 Changes in condition and care provided 
are time stamped and logged 

 Create your own scenarios - add/edit 

 Change simulator’s condition during the 
scenario 

20” ALL-IN-ONE TOUCH SCREEN 
PC TO DISPLAY VITAL SIGNS 

 Display the simulator vital signs in real 
time 

 Use preprogramed layouts or create 
your own configuration to mimic the real 
patient monitors used in your facility 

 Share images such as ultrasounds, CT 
scans, lab results 

 Touchscreen control 

PORTABLE FUSION HD™ 
(OPTIONAL) 

 Record and synchronize video with the 
simulation event information for 
debriefing 

 One (1) wireless camera 

 One (1) USB cameral with built in 
microphone 

INCLUDES 

 One UNI control tablet PC 

 ETC Fusion Recording and debriefing 
system (optional) 

 Vital Signs Monitor 

 Four (4) abdominal wall inserts 

 Twelve (12) uterine assemblies, four (4) 
of each type 

 CD-ROM demonstration video  

 Soft sided case with rollers 

 Surgical Chloe Workbook by Martin E. 
Olsen, MD 

 User Guide 
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Equipment Setup 
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Surgical Chloe 
Setup 

LEG ASSEMBLY 

To install the lower legs: 

 Remove the fixed bolts from the knee 1.
joints using the hexagonal wrench 
included. 

 

 Position the lower legs and re-insert the 2.
knee joint bolt. Then, secure the knee 
bolts without over tightening.  

 

POWER SUPPLY 

Connect the power adapter labeled “Surgical 
Chloe” to the power input port located on 
Surgical Chloe’s right side.  

 

Chloe is equipped with an internal backup 
battery. During simulation, the power adapter 
can be briefly disconnected to transport 
Chloe from one room to another. 

The backup battery level is displayed on the 
UNI status panel. For more information 
about the backup battery indicator, go to 
page 40. 

Do not store the simulator with a 
discharged battery. Re-charge the 
system at least once every 30 days 
when not in use. Otherwise, 
permanent loss of capacity might 
occur. 

Control Tablet PC  
The tablet PC is preloaded with the UNI 
control software used by the facilitator to 
initialize the simulator and control the vital 
signs.  

The Surgical Chloe S2101 package includes: 

 Tablet PC 

 Streaming audio headset 

Before turning on the computer for the 
first time, please review the 
documentation included with the 
product for important care and 
warning information. 

USING THE STYLUS 

The tablet’s stylus is a pen-shaped input 
used to interact with files and programs.  

 Left click - tap the screen with the 
pointer. Tap twice rapidly to double-
click. 

 Right click- tap and hold a highlighted 
item or hold the button near the pointer 
and tap the item or text. 

CALIBRATING THE STYLUS 

As part of the initial setup, calibrate the 
stylus using the Tablet and Pen calibration 
tool in the Windows

®
 control panel. For 

greater accuracy, complete the calibration 
process while holding the pen in a natural 
writing position. 
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WIRELESS COMMUNICATION 
USB MODULE 

The controlling computer transmits the 
startup and control commands to simulator 
through the USB RF communication module. 

Connect the RF communication module to 
an available USB port on the tablet. 

 

Secure the RF communication module to the 
tablet using the hook and loop fabric patch. 
The tablet is now ready to communicate with 
the simulator wirelessly.  

USB COMMUNICATION MODULE 
WIRED 

The USB communication module is also 
equipped with a wired communication port 
used for diagnostics and service. In those 
instances where wireless communication is 
not allowed, the wire port can be used for 
transmitting the startup and control 
commands to the simulator. 

 

Do not connect the simulator to 
Ethernet cards, LAN networks, or 
unauthorized diagnostic equipment. 
Doing so may cause damage to the 
system. 

To connect the simulator to the Tablet PC 
using the wired option: 

 Connect the RJ45 cable to the USB 1.
communication module. 

 

 Connect the RJ45 cable to the 2.
communication port on the simulator’s 
right side. 

 

 Connect the communication module to 3.
an available USB port on the tablet PC. 

 

The tablet is now ready to communicate with 
simulator. 

STREAMING AUDIO HEADSET 

The computer system includes a headset 
that allows the facilitator to speak as Chloe’s 
voice and listen to the participants reply. 

Connect the headset MIC and Speaker 
connectors to the designated ports on the 
left side of the tablet PC. 

 

Always connect the streaming audio 
headset before starting the UNI 
software. 
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Virtual Monitor 
The Gaumard Monitors software displays 
Chloe’s simulated vital signs in real time. 
The interactive monitoring software is 
preloaded in to the virtual monitors PC.  

The virtual monitor PC also allows the 
facilitator to play back the session recordings 
stored in the PRO+ PC for debriefing. 

 

 

VIRTUAL MONITOR PC SETUP 

Refer to the manufacturer’s documentation 
included with the virtual monitor system 
components for important safety, installation, 
and start-up information before turning on 
the computer for the first time. 

To setup the virtual monitor PC: 

 Place the all-in-one PC within line of 1.
sight of the controlling computer 

 Connect the power supply 2.

 Connect the USB keyboard and mouse 3.
receiver 

 Turn on the computer 4.

VIRTUAL MONITOR WIRELESS 
CONNECTIVITY 

The control PC and the all-in-one virtual 
monitor PC automatically establish a 
wireless link at startup. The wireless 
connection allows the Gaumard control 
software to transmit the vital signs 
information to the Gaumard Monitors 
software.  

To verify the wireless link between the two 
computers, click the wireless icon located on 
the task tray. The wireless network name is 
randomly generated at the factory and may 
differ from the one seen below. To 
troubleshoot connection issues, please go to 
page 55. 

 

GAUMARD MONITORS 

After the wireless connection is established, 
double click or tap the Gaumard Monitors 
icon to start the vital signs software.  

 

The Gaumard Monitors software is now 
ready to receive the vital signs information 
generated by the UNI control software. 
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For more information about the Gaumard 
Monitors software, please refer to the 
Gaumard Monitors user guide. 

 

Initializing Chloe  
After reading the manufacturer’s care and 
caution information, press the power button 
to turn on the Tablet PC. 

 

The UNI software initializes the simulator. 
Double click the UNI icon on the tablet’s 
home screen to start.  

 

The simulator selection menu is shown. 
Select Surgical Chloe and click “Start”. 

 

 

The wireless link between UNI and the 
simulator is established within 1 minute. 
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Working with    
Surgical Chloe 
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Category Feature 

Airway Nasal and airway intubation 

Airway sounds 

Breathing Respiratory patterns 

Anterior lung sounds 

Bilateral chest rise and fall 

Pulmonary ventilation: BVM, mechanical 

Cardiac Audible heart sounds 

Electrocardiogram sites 

Compressions and ventilations are detected and logged 

Circulation Bilateral Pulses – carotid, brachial and radial 

Bilateral IV arms 

Blood pressure with Korotkoff sounds – Left arm 

Intramuscular injection placement sites 

Systemic Oxygen saturation on left index finger 

Eyelid state Open/Close (manual) 

Supine or semi-recumbent positions 

Surgical Abdominal wall insert 

Laparoscopy abdominal wall 

Bowel overlay insert 

Ovarian arterial and venous bleeding 

Uterine arterial and venous bleeding 

Uterine Assembly 1: Normal Uterus with ectopic pregnancy and uterine 
bleeding 

Uterine Assembly 2: Enlarged Uterus with dermoid cyst on one side and 
ectopic pregnancy on the other 

Uterine Assembly 3: Enlarged uterus with embedded fibroids, endometrioma 
on one side, and simple cyst on the other 

Other Streaming audio 

Virtual vital signs monitor 

ETC Fusion Audio, video and debriefing computer (optional) 
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Airway 
NASAL AND ORAL INTUBATION 

Practice airway management techniques such 
as nasal/oral intubation, and suctioning. 

 

Procedure 
Recommended  
Device Size 

Intubation 
(Blade size) 

Miller 4 or MAC 3.5 

LMA Size 4 

Nasal Intubation 
8 mm outer diameter 
max 

Oral Intubation ETT 7 or 7.5 

Warning: 
Do not introduce liquids when 
performing nasal and oral intubation. 
Doing so will damage the system.  

Always lubricate the catheter with the 
silicone lubricant provided before 
intubating. 

AIRWAY SOUNDS 

Use the Detail tab parameter controls to 
change the upper airway sounds on the 
simulator. 

 

Breathing 
RESPIRATORY PATTERNS 

Use the Detail tab parameter controls to 
change the simulator’s respiratory pattern. 

 

ANTERIOR LUNG SOUNDS 

Use the Detail tab parameter controls to 
change the audible respiratory sounds on the 
simulator. 

 

CHEST RISE AND FALL 

Set the respiratory rate higher than zero to 
enable automatic bilateral chest rise and fall. 
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PULMONARY VENTILATION 

Ventilate the simulator using a bag valve mask 
or a mechanical ventilator. Set the respiratory 
rate to “0” to display chest rise during 
ventilation and receive feedback on the CPR 
window. Complete the ventilation calibration 
process before using the ventilation feature for 
the first time. 

 

VENTILATION CALIBRATION 

The ventilation calibration wizard records the 
performance average of five ventilations as the 
benchmark for correct ventilation. Perform the 
actions requested by the calibration wizard 
following the most current CPR guidelines. 
The CPR window evaluates provider 
performance based on the benchmark 
recorded during the calibration process. 

To calibrate the ventilation performance 
benchmark: 

 Click Setup > Calibration > Ventilations, 1.
and click “Next” 

The wizard prompts to perform ventilation “#1” 

 Perform the first ventilation. A green filled 2.
oval indicates that the ventilation was 
recorded successfully 

 Perform ventilation # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the ventilation was recorded 
successfully 

 Continue through the calibration wizard to 4.
record a total of five ventilations 

At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the calibration settings. 

 

 

Cardiac 
AUDIBLE HEART SOUNDS 

Use the Detail tab parameter controls to 
change the audible heart tones on the 
simulator. 

 

ELECTROCARDIOGRAM SITES 

Connect real EKG electrodes to the four 
conductive sites and monitor Chloe’s heart 
rhythm (Lead II) using a real heart monitor.  

  

 

Warning:  
Do not pace or defibrillate the simulator. 
Doing so will result in damage to the 
simulator’s electrical components. 

Use the virtual shock panel to simulate the 
administration of electrical therapy. Enable the 
virtual shock panel from the menu bar. 
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SELECTABLE HEART RHYTHMS 

UNI features a library of heart rhythms. Select 
the rhythm from the list and apply the change 
to view the waveforms on the monitor. 

 

CLEANING THE 
ELECTROCARDIOGRAM SITES 

Maintain the electrocardiogram sites clean for 
accurate readings. In addition, reference the 
following guidelines: 

 Always clean the conductive sites at the 
end of simulation. 

 Do not leave ECG electrodes attached for 
use the next day 

 NEVER attempt to service or modify any 
of the electrical connections, especially 
those between conductive skin sites and 
the internal electronics. Discontinue use if 
any wires are found exposed with 
damaged insulation. 

 Use a gentle degreasing cleanser or soap 
and water to clean the electrocardiogram 
sites. 

 If dark traces appear on the 
electrocardiogram sites, use a pencil 
eraser to remove the traces and then 
clean with alcohol or soap and water.  

 Do not scratch the conductive patches 
with abrasive objects; doing so will cause 
irreversible damage to the conductive 
sites. 

 

CHEST COMPRESSIONS 

Set the heart rhythm to asystole and instruct 
the provider to perform chest compressions. 
Monitor the depth and frequency of chest 
compressions from the CPR trainer window. 
Before using the chest compression feature for 
the first time, please calibrate the chest 
compression feature.  

COMPRESSION CALIBRATION 

The compression calibration wizard records 
the performance average of five compressions 
as the benchmark for a correct compression. 
Perform the actions requested by the 
calibration wizard following the most current 
CPR guidelines. The CPR window evaluates 
provider performance based on the benchmark 
recorded during the calibration process. 

To calibrate the compression performance 
benchmark: 

 Click Setup > Calibration > Compressions, 1.
and click “Next” 

The wizard prompts to perform compression 
“#1” 

 Perform the first compression. A green 2.
filled oval indicates that the compression 
was recorded successfully 

 Perform compression # 2 as prompted by 3.
the wizard. A green filled oval indicates 
that the compression was recorded 
successfully 

 Continue through the calibration wizard to 4.
record a total of five compressions 
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At the end of the calibration process, the 
wizard reports the average peak, pressure, 
and duration values for the procedure. Click 
“Save” to store the calibration settings. 

 

COMPRESSIONS AND 
VENTILATIONS (CPR) 

Ventilations and compressions are measured 
and logged. For more information on the CPR 
trainer, go the digital UNI User Guide under 
the software Menu/Help/Instruction Manual. 

 

Circulation 
PULSES  

Chloe is equipped with palpable bilateral 
carotid, brachial, and radial pulses. Pulse 
strength is blood pressure dependent. Use the 
Detail tab parameter controls to disable the left 
radial pulse. 

 

BILATERAL IV ARMS 

Use the bilateral IV training arms for bolus or 
intravenous infusions as well as for drawing 
fluids.  

 

Warning:  
Do not attempt to fill IV system without 
the drain connector in place. 

Always leave the drain port connected 
when injecting fluids into the system. 

Use only Gaumard provided simulated 
blood. Any other simulated blood brand 
containing sugar or any additive may 
cause blockage and/or interruption of 
the vasculature system. 

At the end of every exercise, purge 
vascular system with 70% isopropyl 
alcohol solution. Then, purge the 
system with air to dry the veins. 

To fill the arm vasculature for drawing fluids: 

 Locate the filling kit that includes the fill 1.
syringe, syringe adapter, and the drain 
tube with the pinch-clamp.  
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 Fill the syringe with water or simulated 2.
blood. 

 Connect the filling syring to an available 3.
white port  

 

 Connect the drain tube to the other port as 4.
shown and open the pinch clamp. Place 
the end of the drain tube into a container. 

 

 Depress the syringe until fluid exits the 5.
drain tube and all the air bubbles are 
purged.  

 

COLLAPSIBLE VEINS 

To simulate a patient with no accessible 
peripheral IV sites, connect the fill syringe only 
and pull the plunger to create suction. Doing 
so will collapse the veins. Disconnect the 
syringe tube from the arm port while 
maintaining suction. The port will seal, and the 
veins will remain collapsed. 

CLEANING THE IV ARMS 

Purge the arm veins with 70% isopropyl 
alcohol solution at the end of the day to 
prevent mold. Then, repeat the filling 
procedure with air to purge left over fluid and 
dry the veins. 

BLOOD PRESSURE WITH 
KOROTKOFF SOUNDS 

Measure the programmable blood pressure on 
the left arm using a standard sphygmo 
manometer. Use a real stethoscope to 
auscultate the Korotkoff sounds.  

Before using the blood pressure feature for the 
first time, place the blood pressure cuff on the 
arm and complete the calibration the process 
outlined on to the digital UNI User Guide under 
the software Menu/Help/Instruction Manual. 

To get a blood pressure reading: 

 Put the blood pressure cuff around the 1.
simulator’s upper left arm with the cuff 
mark at the medial site of the bicep 
brachii, about an inch (two cm) above the 
anterior elbow. 

 

 Inflate the BP cuff, and auscultate 2.
Korotkoff sounds using the standard 
techniques practiced on a human patient. 
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INTRAMUSCULAR INJECTION 
PLACEMENT SITES 

Intramuscular injection sites for placement 
exercises are located on both deltoids and 
quadriceps. 

 

Do not inject fluids into the IM sites. The 
sites only allow for placement and 
technique exercises. 

 

Systemic 
OXYGEN SATURATION 

Use commercially available monitors to read 
oxygen saturation from the left index finger. 

Before using the oxygen saturation feature for 
the first time, complete OSAT calibration 
procedure. 

 

Co-oximeters that in addition to reading 
oxygen saturation also read carbon 
monoxide (SpCO) and methemoglobin 
(SpMet) are not supported and may 
provide inaccurate readings. 

OXYGEN SATURATION 
CALIBRATION 

UNI stores the calibration settings for one 
device at a time. If the oxygen saturation 
monitor or the sensor is changed, the 
simulator must be recalibrated to work with the 
new device. 

To calibrate the oxygen saturation finger: 

 Turn OFF the oxygen saturation monitor 1.
and place the oximeter sensor on the left 
index finger. Verify that the left index 
finger is centered inside the finger sensor. 

 Go to Setup>Calibration and select 2.
“Oxygen Saturation”. Click “Next” to 
continue. 

 Turn ON the oximeter and click “OK” on 3.
the dialog box. 

 Adjust the reading on the oximeter 4.
monitor screen to match the value 
displayed on the UNI calibration screen 
using the arrows on the left column of the 
calibration window. The first calibration 
point is 98%. 

Use the triple arrows to increase or decrease 
the reading on the oximeter in large intervals, 
double arrows for moderate changes, and the 
single arrows for small changes of one or two 
percent readings.  

Wait 10-15 seconds after making an 
adjustment to allow the oximeter reading to 
stabilize. Doing so ensures proper calibration. 

 After the reading on the OSAT monitor is 5.
stable and it matches the value on the 
UNI calibration window, click “OK”, and 
then “Next” to continue. 

 Repeat the process to calibrate the 6.
following intervals. 

 Click “Finish” at the end of the calibration 7.
and remove the OSAT monitor from the 
finger. 

INSTRUCTIONS FOR USE 

 Start UNI and establish communication 1.
with the simulator. 

 Connect the oximeter probe to the left 2.
index finger of the simulator. 
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 Turn on the monitor. 3.

 Adjust the oxygen saturation using the 4.
UNI software controls. 

EYELIDS 

Manually open or close the eyes individually. 

SUPINE OR SEMI-RECUMBENT 
POSITIONS 

Chloe can be rested in supine or semi-
recumbent positions. 
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Surgical 
OVERVIEW 

Surgical Chloe is designed to address 
competencies in six different areas, including:  

 Patient care  

 Medical knowledge 

 Practice based knowledge and 
improvement 

 Systems based practice 

 Communication  

 Professionalism  

SURGICAL CHLOE WORKBOOK 

The Surgical Chloe Workbook bundled with 
this package includes supplemental 
information intended to enhance the surgical 
simulation exercises. Each section of the 
workbook includes the following information for 
each preprogrammed scenario: 

 Preoperative, intraoperative, and 
postoperative checklist forms.  

 Scenario exercise overview  

 Patient history 

 Laboratory test values 

 Simulation parameters 

 Expected actions by participants 

 List of personnel/props 

 List of competencies addressed by 
each scenario 

 Debriefing goals 

The Surgical Chloe Workbook also contains 
helpful information for implementing a 
comprehensive simulation scenario. Moreover, 
it lays out a template for the level of detail that 
makes simulation effective. It is not a 
substitute for a comprehensive understanding 
of the subject matter, and it is not intended for 
clinical decision-making. 

UTERINE ASSEMBLY OVERVIEW 

A uterine assembly is a removable insert 
designed to simulate the anatomy and tissue 
properties of the female reproductive system 
with pathologies. Chloe includes three unique 
uterine assemblies, Uterine Assembly 1, 
Uterine Assembly 2, and Uterine Assembly 3. 

Uterine Assembly 1 is preinstalled. For 
information on how to change or 
replace a uterine assembly, go to page 
36. 

UTERINE ASSEMBLY 1 

“Uterine Assembly 1” features a normal sized 
uterus with a ruptured ectopic pregnancy and 
uterine bleeding. 

Additional possible procedures include: 

 Treating an ectopic 

 Dilation and curettage 

 Treating a bleeding disorder 

 Vaginal or abdominal hysterectomy 

 Performing bladder repair 

 

“Uterine assembly 1” is equipped with pinch 
clamps used to occlude blood to the 
complication not used during an exercise. Prior 
to starting a scenario, open or close pinch 
clamps as needed for the applicable exercise.   

 

 

Feature Location 

Ectopic pinch clamp 1 

Uterine pinch clamp 2 

2 
1 
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RUPTURED ECTOPIC 

To allow blood flow to the ruptured ectopic, 
open the Ectopic Flow clamp (1) and close the 
Uterine Flow clamp (2). This will allow only the 
ruptured ectopic to hemorrhage when the 
venous flow is enabled via the UNI software 

UTERINE BLEEDING 

To allow blood flow through the cervix as in the 
case with Von Willebrand’s, open the Uterine 
Flow clamp (2) and close the Ectopic Flow 
clamp (1). This configuration will only allow the 
uterus to bleed when the venous flow is 
enabled.     

                       

Always lubricate the surgical tools prior 
to performing a pelvic exam. Doing so 
will prevent damaging the uterine 
assembly. 

UTERINE ASSEMBLY 2 

“Uterine Assembly 2” features an enlarged 
uterus with a ruptured ectopic pregnancy and 
a dermoid cyst. Possible procedures include: 

 Treating an ectopic  

 Removing a dermoid cyst  

 Performing bladder repair 

 Suction curettage 

 Removing products of conception as 
in septic abortion  

 Performing a vaginal hysterectomy 
with morcellation or an abdominal 
hysterectomy 

“Uterine assembly 2” is equipped with a 
manual flow valve on the left ovarian artery. 
Close the Ectopic Flow clamp to disable the 
blood flow to the area if the scenario does not 
involve the ruptured ectopic. 

 

UTERINE ASSEMBLY 3 

Uterine Assembly 3 includes an enlarged 
uterus with embedded fibroids, an 
endometrioma, and a simple cyst. Possible 
procedures include: 

 Performing an abdominal 
myomectomy 

 Removing an endometrioma  

 Removing a Cyst 

 Dilation and curettage, suction 
curettage 

 Performing bladder repair  

 Performing a vaginal hysterectomy 
with morcellation or an abdominal 
hysterectomy 

 

GENERAL UTERINE ASSEMBLY 
FEATURES 

All three uterine assemblies include the 
following anatomical features: 

 Bladder 

 Ovaries 

 Fallopian tubes 

 Peritoneum 

Closed  Open  
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 Perineum with integrated vagina 

 Ovarian and uterine arteries and 
veins 

 Ligaments: uterosacral, 
infundibulopelvic, round, and cardinal 

 

Each uterine assembly allows for several 
surgical procedures when performed in order. 
All three assemblies allow for the following 
procedures:  

 Unilateral oophorectomy 

 Conization of the cervix 

 Chromopertubation 

 Hysteroscopy 

Always lubricate the surgical tools prior 
to performing a pelvic exam. Doing so 
will prevent damaging the uterine 
assembly. 

Abdominal Covers 

Chloe includes two separate abdominal covers 
for laparotomy and laparoscopic exercises. 

 

LAPAROTOMY COVER 

The laparotomy abdominal wall covers the 
abdomen and holds the abdominal insert in 
place. 

 

The replaceable abdominal insert is designed 
to react like real skin when cut, clamped, or 
sutured. It simulates the look and feel of the 
skin, subcutaneous tissue, fascia, muscle, and 
peritoneum. 

The fascia allows for a Pfannenstiel incision 
and the subcutaneous layer has built in blood 
sacks that rupture when cut. 

 

One abdominal insert is preinstalled on the 
laparotomy cover. Each abdominal insert can 
be used to perform up to 4 surgical incisions. 
For information on replacing and installing a 
new abdominal insert, go to page 37. 

Do not use electrosurgical or 
cauterization tools on any of the uterine 
assemblies or abdominal covers. 



Surgical Chloe | Surgical | 29 

LAPAROSCOPIC COVER 

The laparoscopy cover allows participants to 
perform minimally invasive surgical exercises. 
The cover features 8 pre-placed ports that can 
be used to insert trocars.  

Always lubricate the surgical tools prior 
to insertion. Doing so will prevent 
damage to the laparoscopy ports. 

For exercises focused on trochar 
insertion technique, use the 
Laparotomy cover instead. 

 

Preparing for a Scenario  

FILLING THE SIMULATED BLOOD 
RESERVOIRS 

Chloe is equipped with internal fluid reservoirs 
that supply the ovarian and uterine 
vasculatures with simulated blood. The blood 
reservoirs are located inside the right and left 
upper leg. The blood flow is activated using 
the UNI software controls. 

Feature 
Fill port 
location 

Capacity 

Venous 
reservoir 

Left leg 
750 mL 

Arterial 
reservoir 

Right leg 
750 mL 

Only use simulated blood provided by 
Gaumard. Any other simulated blood 
brand containing sugar or additives 
may cause blockage and/or interruption 
of the vasculature system. 

To fill the internal reservoirs: 

 Turn off the arterial and venous bleeding 1.
and set the simulator to stand-by to 
release the internal reservoir pressure. 

 

 In a separate container, mix the Gaumard 2.
artificial blood substitute with 1 gallon of 
water and shake vigorously until the 
product has fully dissolved. 

 Attach the filling adapter tube to the 60 cc 3.
syringe and fill it with simulated blood. 

 Connect, turn, and lock the filling syringe 4.
to the arterial reservoir port located behind 
the right knee and inject 750 mL of 
Gaumard blood substitute. 

 

 Connect, turn, and lock the filling syringe 5.
to the venous reservoir port located 
behind the left knee and inject 750 mL of 
Gaumard blood substitute. 

PRIMING THE UTERINE ASSEMBLY 

After the uterine assembly is installed and the 
reservoirs are filled, purge the vasculature of 
any trapped air that may occlude the blood 
flow.  

To purge the trapped air in the vasculature: 

 Disconnect the ovarian vein and artery 1.
from the right side of the abdomen only. 
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If the uterine assembly is equipped with a 
pinch valve, keep the artery connected and 
open the valve to allow the trapped air to 
escape.  

 Turn on the ovarian and uterine 2.
vasculature blood flow using the Details 
tab controls. 

 

 Please wait until the blood flows through 3.
the arteries and veins purging the trapped 
air. The process may take up to 30 
seconds. 

 

 Reconnect the vein and artery. 4.

 

 Repeat the process to purge the uterine 5.
vasculature. 

 Turn off the blood flow using the Details 6.
tab controls. 

 

Scenario Walkthrough 

RUPTURED ECTOPIC BRANCHING 
SCENARIO WALKTHROUGH 

The preprogrammed Ruptured Ectopic 
Scenario presents a hemodynamically 
unstable patient whose condition worsens 
unless the ruptured ectopic is treated in time.  

See the Surgical Chloe DVD for a 
complete walkthrough of this scenario. 
Additional information including patient 
history, laboratory results, and 
debriefing goals information is included 
in the Surgical Chloe Workbook. 

To prepare CHLOE for the ruptured ectopic 
scenario: 

 Install Uterine Assembly 1 or Uterine 1.
Assembly 2 

 Fill the arterial and venous reservoirs with 2.
simulated blood 

 Prime the uterine assembly 3.

 Open the ectopic flow clamp 4.

 Install the bowel insert 5.

 Install the laparotomy cover 6.

Each assembly allows for a minimum of 
four procedures. Carefully plan the 
order of procedures and exercises to 
increase the usability of each uterine 
assembly.  

UNI BRANCHING SCENARIO 
SCREENS 

From the UNI menu bar, click File > “New 
Session” to start a new event log file. Then, go 
to the “Quick Launch” and click “Ruptured 
Ectopic” to start the scenario. 
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To complete the scenario, the participants are 
to assess the patient in the ER, diagnose 
hemodynamic instability, diagnose the ectopic 
pregnancy, and quickly rush the patient to the 
operating room for a definitive surgical 
procedure. The team will have 20 minutes 
after onset of bleeding to achieve these goals.  

 

If the participants are not meeting the 
competencies and goals within the allotted 
time, the facilitator can choose to give the 
participants more time by check marking the 
"Stop Bleeding Option" to restart the current 
palette item and disable the bleeding. 

 

As the participants complete the 
competencies, checkmark the “Hemorrhage 
control”, and “Blood given” key events to move 
the scenario to “Node 2 - recovery”. 

 

The palette items programmed into “Node 2 - 
Recovery” improve the patient’s condition 
while the surgery is completed. 

 

 

 

 

SURGERY 

The Surgeon incises the skin of the abdominal 
insert using real surgical instruments.  

Do not use electrosurgical or 
cauterization cutting tools. Doing so will 
result in damage to the materials.  

 

The subcutaneous tissue is revealed as the 
skin is separated.  

 

The abdominal wall fascia is incised. 

 

The fascia is separated from the underlying 
rectus muscle. 
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The peritoneum is incised carefully. 

 

RECORDING USING PORTABLE 
FUSION HD™ (OPTIONAL) 

During the simulation, the Portable Fusion 
HD™ system records the internal pelvic 
camera feeds, the surgeon’s view, the 
overhead view, and the patient’s vital signs 
screen. The audio and video information is 
synchronized with the UNI event log and 
stored in the PC for debriefing. For detailed 
information about the Fusion software, go to 
page 46. 

 

Switch to the Portable Fusion HD™ recording 
screen for a larger view of the live procedure.  

 

Audience members can view a live 
video feed of the procedure from a PC 
connected to the Portable Fusion HD™ 
wireless network. For more information 
about the remote Dashboard feature, 
please refer to the ETC Fusion manual. 

The ectopic pregnancy is visualized. 

 

The bleeding ruptured ectopic is identified. 

 

The ectopic pregnancy is isolated. 

 

After clamping the fallopian tube, a 
salpingectomy is performed. 

 

The fallopian tube stump is ligated. 
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The suture is cut, knot integrity is verified, and 
hemostasis is achieved.  

 

Fascial closure of the abdominal wall is 
initiated. 

 

The skin is closure is completed. 
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Post Simulation 
Maintenance and Care 

After the simulation and debriefing session is 
over, complete the post simulation 
maintenance and care procedures to prevent 
mold and clogs in the vasculatures. 

 Remove the Uterine Assembly and clean 
the simulated blood residue 

 Purge the simulated blood from both 
reservoirs 

 Clean the reservoirs with distilled water 

 Drain the reservoirs 

REMOVING THE UTERINE 
ASSEMBLY 

To remove or replace the uterine assembly: 

 Disconnect all four ovarian veins and 1.
artery quick connect fittings. 

 

 Disconnect all four uterine veins and 2.
artery quick connect fittings. 

 

 Detach the Velcro that secures the 3.
assembly in place by carefully pressing 
down and around the outside of the 
assembly. 

 

 Slide the uterine assembly out the bottom 4.
of the torso. 

 

 Clean the Velcro and the abdominal cavity 5.
using a damp cloth with diluted soap and 
water. 

CLEANING THE FLUID 
RESERVOIRS 

Purge both internal blood reservoirs to prevent 
mold and clogging. Please remove the uterine 
assembly before continuing. 

Always purge and drain the arterial and 
vein reservoirs at the end of the 
simulation session. Doing so will 
prevent mold and buildup. 

To drain the remaining simulated blood: 

 Connect the drain tube to the arterial and 1.
vein ports 
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 Place the drain tube into a container to 2.
collect the remaining blood. For best 
results, position the container below the 
simulator  

 Turn on to arterial blood flow using the 3.
Details page controls. 

 

 Allow the system to purge the simulated 4.
blood into the container. 

 

 Repeat the procedure to drain the 5.
remaining arterial and venous ports. 

 

 Leave the drain tubes connected to clean 6.
the system using distilled water 

To clean the system with distilled water: 

 Turn off the blood flow and refill the 1.
arterial and venous reservoirs with 
distilled water using the fill syringe. 

 

 

 Enable the arterial and venous bleed 2.

 

 Allow the distilled water to drain into the 3.
container until clean water flows through 
the drain tubes 

 

 Repeat the procedure to flush the 4.
remaining arterial and venous ports. 

 Turn off the arterial and venous bleed 5.
when no more clean fluid is exiting the 
drain tube 
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INSTALLING A UTERINE 
ASSEMBLY 

Before installing the uterine assembly, clean 
and dry the Velcro attachments to prevent 
molding or staining. 

 Wrap the assembly’s Velcro fastener strip 1.
with the clear plastic bag that the uterine 
assembly was shipped in. 

 

 Align the uterine assembly with the pubis 2.
and coccyx. 

 

 Slide the uterine assembly into position on 3.
the torso. Make any final positioning 
adjustments needed and slide the plastic 
bag out.  

 

 Press the uterine assembly Velcro against 4.
the circumference of the pelvis to secure it 
in place.   

 Connect, turn, and lock the uterine 5.
arteries and veins quick connectors 
located in the lower torso. The quick 
connectors are color-coded; black 
connectors identify the arteries and white 
connectors identify the veins. 

Feature Connector color 

Artery white 

Vein black 

 

 To connect the ovarian veins and arteries, 6.
first loop the tubes into position to prevent 
kinks and then lock the connectors to the 
ports. 

 

 Check for kinks in the vasculature.  7.

Go to page 26 for information on the pinch 
clamps used to occlude blood and disable 
specific pathologies. 
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REPLACING THE ABDOMINAL 
INSERT 

The abdominal insert allows for up to four 
incisions. To remove and install a new 
abdominal insert: 

 Position the Laparotomy Abdominal Wall 1.
face down on a clean flat surface and 
remove the 6 nylon screws holding the 
abdominal wall Insert Support. 

 

 Remove the Abdominal Wall Insert 2.
Support. 

 

 Pull the Abdominal Wall Insert upwards so 3.
that the skin layer is brought through the 
surgical window. 

 

 

 

 

 

 Remove the screws. 4.

 

To install a new abdominal wall insert: 

 Fit the insert in the surgical window by first 1.
passing the skin layer through the opening 

 

 Align the thru holes of the Abdominal Wall 2.
Insert with those of the Abdominal Wall 

 

 Insert all the nylon screws through the 3.
Abdominal Wall and abdominal Insert so 
that the heads lay flat against the Skin 
surface of the abdominal wall  
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 Align and place the Abdominal Wall 4.
Support on the nylon screws 

 

 Secure the assembly using the acorn 5.
fasteners 
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Working with UNI
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UNI Interface 
The UNI software is used control the simulator, monitor the vital signs, and evaluate the provider’s 
performance. The simulation technician or instructor carrying out the simulation operates the UNI 
software 

The UNI control elements and scenario programming procedures are consistent throughout the 
Gaumard family of high fidelity simulators. Some software controls and features covered in this 
guide may be hidden depending on the simulator’s hardware configuration and optional upgrades 

 

 

 

CONNECTION STATUS 

The communication indicator displays the 
status of the radio link between the tablet’s 
USB RF module and the simulator. Full bars 
indicate excellent communication (i.e., 
normal operation). 

 

BATTERY INDICATOR 

The battery indicator displays the battery 
charge information. An exclamation sign is 
shown when there is no communication with 
the simulator and battery information cannot 
be retrieved. 

 

 

 

 

 

When the battery icon is depleted, the 
simulator is set to STAND-BY mode 
automatically to protect some of the 
simulator’s internal components.  

Simulator will not initialize until connected to 
the charger or the battery is replaced with a 
fully charged spare. 

 

Feature Runtime 

Internal Battery Approx. 4  hours 



Surgical Chloe | Surgical | 41 

SESSION CLOCK 

The session timer displays the duration of 
the current session. Click the timer to reset 
the clock or to start a new session. Event 
entries in the text log are synchronized with 
the session timer. 

 

POWER/STAND BY 

The power button is located at the bottom 
right corner of the UNI software. Toggle the 
power button to set the simulator to stand-by 
mode and then again to resume. 

 

For more information about the UNI 
software, refer to the digital User Guide 
under Menu/Help/Instruction Manual.
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Status / Details 
Controls 
The Status/Details panel is used to monitor 
and control the simulator’s vital signs. The 
individual parameter controls displayed on 
the details tab provide the simplest method 
for controlling the simulator’s vital signs, 
sounds, and features.  

The Status/Details tab displays the vital 
signs controls in a list format.   

SYSTEMS LIST VIEW 

 

The Status/Details panel is used to monitor 
and control the simulator’s vital signs. The 
individual parameter controls displayed on 
the details tab provide the simplest method 
for controlling the simulator’s vital signs, 
sounds, and features.  

 

CHANGING VITAL SIGNS 

To adjust numerical values click the slider 
control. (e.g. heart rate, blood pressure, 
respiratory rate, etc.).  

 

Alternatively, use the keyboard for manual 
entry and click the green checkmark to 
confirm the change.  

 

To change patterns, sounds, and rhythms, 
click on the specific control to display the 
library (e.g. EKG rhythms, heart and lung 
sounds, respiratory patterns, etc.) 
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Click the slider control below the sound 
library to adjust the volume of the sounds.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

APPLYING CHANGES 

 

No changes will be made to the simulator’s 
condition until the new settings are submitted 
using the “Apply” panel. After the list of 
changes is created, click “NOW” to update 
the vital signs instantly. Alternatively, click a 
trending timer to update numerical vital sign 
parameters (e.g. heart rate, blood pressure) 
gradually.  
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Vital sign parameters can be edited or 
removed using the edit and remove 
parameter tabs 

  

Enable the “instant apply” option and click 
the control to change the vital sign to a new 
value without the need to use “Apply” panel. 
Vital signs undergoing change blink yellow. 

 

CREATING PALETTE ITEMS 

A palette item stores one or more vital sign 
settings into a single loadable object. Use a 
palette item to update a set of vital signs 
quickly. For example, one palette item can 
be created to update all the cardiac 
parameters to a healthy state.  

To create a new palette item, set the values 
for the desired vital signs parameters using 
the details controls and click “Save”.  

 

Enter a name for the palette, a description, 
and choose color code. Click “Save” to 
create the new palette Item. Palette items 
are stored in the active profile. 

 

When the palette is needed, click the Load 
button to select the palette from the library. 

 

 

Select the palette item from the “Load 
Palette Item” menu and click “Load” 

 

Click the apply option to submit the changes. 
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Debriefing 
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Portable Fusion 
HD™ PC  
(Optional) 
The Portable Fusion HD™ system allows the 
facilitator to monitor and record the 
simulation session, and debrief, all from one 
PC. 

 

The Surgical Chloe S2101 Portable Fusion 
HD™ package includes: 

 ETC Fusion PC and power supply 

 One (1) wireless overhead camera 

 One (1) USB camera with built in 
microphone 

 USB extender 

PORTABLE FUSION HD™ 
CAMERAS 

The cameras allow the facilitator to monitor 
and record footage of the simulation from 
various angles. The video feed is 
synchronized with the event log information 
generated by the UNI software and stored in 
the ETC Fusion PC for debriefing. 

WIRELESS OVERHEAD CAMERA 

The wireless overhead camera records a 
general view of the operating table. 

To setup the wireless camera, first connect 
the camera to the power supply and then 
place the camera high above the operating 
table.  

 

The wireless camera will automatically 
establish a connection when the PC is 
powered on. 

WIRED CAMERA 

The wired camera is connected via USB 
directly to the computer.  

To setup the wired camera, attach the clamp 
to the bottom of the camera. Plug in the 
cable to the computer or utilize the USB 
extender for more range. Clamp the camera 
anywhere for a close-up view of the 
operation. 

 

Do not clamp the camera to the PC 
bezel. 

Portable Fusion 
HD™  
The pre-loaded with audio/video recording 
capabilities. The system allows the facilitator 
to record footage of the simulation. After 
simulation is complete, review the footage 
with the participants on the virtual monitor 
PC to complete the debriefing.  

Reference the Surgical Chloe 
Workbook for information on 
debriefing goals for each of the 
preprogrammed scenarios in the UNI 
software. 
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Before using the system for the first time, please reference the setup information on page 13 to 
ensure the simulator is connected properly. 

Portable Fusion HD™ Interface 

 

 

 ETC Fusion Settings - access the main options 1.

 ETC Browser - search the local area network for ETC enabled and broadcasting computers  2.

 Help - contact KBport or reference this menu for any questions 3.

 Update - run software updates the ETC system from here 4.

 Notification - ETC detects when update is available 5.

 Storage - obtain information on the storage of the internal device    6.

 Camera Settings - make changes to the existing cameras and add additional cameras to ETC 7.

1 

3 

4 2 

5 

6 
7 
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Debrief  

Access the previous scenario recordings in the Debriefing tab in the top left of the screen.  

 

 

1. Recordings - select video files here 

2. Controls - Play back, edit, and export video files.  

 

Refer to the ETC Fusion Manual for more information on how to use the ETC Fusion 
laptop.

1 

2 

2 
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More about scenarios 
THINKING IN TERMS OF PALETTE ITEMS 

As described previously, palette items represent complete or partial groups of settings that have 
been stored as a single item. Applying partial states will hold constant all settings that are left 
unspecified. 

Not only does it take time to customize the palette, but a very large palette becomes difficult to 
navigate. So, it is desirable to minimize the number of Palette Items in each Profile. To accomplish 
this, an experienced facilitator tries to create items that are as generally applicable as possible and 
can therefore be applied to a wide range of scenarios. The key is to include only in your palette 
items the settings that are directly related to the physiological event represented by that palette 
item. 

SMART SCENARIOS 

After reading the Details, Palette, and Scenarios sections of this guide, it should be clear how to 
build a scenario. You may have already tried building your own or modifying some of the factory 
presets. The following four guidelines will refine your ability to build the best possible scenarios. 

1. How will the scenario begin? 

The first thing to consider is the initial condition of the patient. Create a Palette Item to describe this 
condition. Make sure that this first step in the scenario is a complete state. That is, indicate some 
selection for each available setting on the Details page. Remember that only the settings you 
specify will cause a change in CHLOE, and all other settings will remain constant. Therefore, by 
starting with a complete state, CHLOE’s condition will always be the same when the scenario 
starts, regardless of what she was doing previously. 

Likewise, the "transition duration" of the first step in the scenario should be zero, indicating that 
changes are applied immediately. 

There is one point that can cause confusion and warrants further explanation. It is an extension of 
the above discussion of partial states. The issue is best illustrated through the following example: 

Suppose that you are creating a Palette Item to start your scenario. In this case, you have decided 
that the patient will be apneic. The question is, "How should the lung sounds be set?" 

Most people's first inclination is to set the lung sounds to "none.” This is incorrect, despite apnea. 
Obviously, no lung sounds should be heard during apnea, but since you have already set 
respiratory rate to zero, none will be. (Sounds are synchronized to the breathing cycle.) 

What you are really setting here when you choose a lung sound is the condition of the lungs, given 
respiratory drive. That is, if the patient's respiratory rate were changed from zero, what sound 
would be heard? Assuming that the lungs themselves are normal in this scenario, you would 
choose "normal" for the lung sound setting. 

Then, as the scenario progresses, if the patient starts breathing, there will be no need to set the 
lung sound again. It will already be set. The same principle applies to the heart sound and other 
settings. 

2. Include notes to guide the facilitator during the simulation. 

It is common for scenario designers, especially those who act as facilitators, to neglect the 
importance of notes in the scenario. They think that they will remember the learning objectives, 
patient history, and other details at the time they are ready to conduct the simulation. They usually 
do not, especially when revisiting a scenario months after creating it. 

When you add "Wait" and "Wait Indefinitely" steps to a scenario, you have an opportunity to edit 
the item description. Use this description field to hold notes to the facilitator. Typically, scenario 
designers write notes in that space to indicate what the provider(s) or facilitator should be doing at 
that point. 

Further, when saving the scenario, you may edit the scenario description. This is the best place to 
put patient history and any other longer notes and instructions. 
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3. Assume that providers will do the right thing.  

Usually a scenario should be created with the assumption that the providers will perform correctly. 
As long as they do, the scenario can be allowed to continue. 

Naturally, preparation must be made for what might happen to CHLOE when providers deviate 
from expectations. The consequences of such deviations can sometimes be included in the 
scenario, punctuated by "Wait Indefinitely" items. In other cases, the simulation will require more 
direct control by the facilitator via either the Palette or Details page. 

4. Choose auto-response settings based on the scenario content and the objectives. 

As seen, auto-responses can be used to free the facilitators’ attention. They also enhance realism 
by presenting instant reactions to the care providers. On the other hand, sometimes it is not 
possible or desirable to determine the responses before the simulation begins. Different 
environments and applications call for different settings. 

Some teaching practices are best done with the auto-response settings in Prompt mode. 
Responses must be triggered by a vigilant facilitator. Though it is slower and requires more 
attention, the benefit of Prompt over other modes is that the simulation can be allowed to go in any 
direction, and it will be possible to choose the response on a case-by-case basis. 

Other learning exercises require a higher degree of automation. For such applications, most 
facilitators choose Auto mode for the auto-response settings. The key issue is standardized timing 
of symptom presentation. A consistent, repeatable simulation is essential for fair assessment of 
that care provider in relation to others and for the broader interpretation of results in the context of 
training validation studies. 

When in doubt, it is best to choose Prompt mode, in which the facilitator will be given direct control 
of the responses as events are detected. 
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FACTORY PRESET SCENARIOS 

There are ten preprogrammed branching scenarios in the “Quick Start Chloe” profile. More 
information about each scenario including, simulation overview, lab results, and patient history is 
included in the “Surgical Chloe Workbook”. 

Scenario 
Name 

Description 

Ruptured 
Ectopic 

pregnancy 

Patient presents to the emergency room having been previously evaluated by the ER 
physician, who has already done a positive pregnancy test. She is complaining of 
abdominal pain. She is a 27-year-old G2P1 patient. She did not know she was pregnant 
until she arrived in the emergency room and was told about the pregnancy. She is 
sexually active without contraception. She has a history of chlamydia for which she was 
treated as an outpatient. She is on over-the-counter medications for seasonal allergies, 
no other medications. She has no known drug allergies. She smokes one pack of 
cigarettes per day. She consumes 5 or 6 beers per weekend. She denies any street 
drugs. Physical exam shows a somewhat diaphoretic patient with a heart rate of 120 and 
a blood pressure of 80/40. The lungs are clear; heart is tachycardic, otherwise 
unremarkable. Abdomen is tender. Pelvic exam showed tenderness in the right adnexa 
and some discomfort throughout the exam. 

Pelvic Mass 
in pregnancy 

The patient is a 38-year-old G2P1 at 10 weeks gestation. She presents to the 
emergency room with significant abdominal pain. On questioning, the patient will point to 
her right lower quadrant. If asked, the patient will report decreased appetite, positive 
flatus and increased pain when riding to the emergency room when the car went over 
bumps.  

The patient’s history includes one previous vaginal delivery at term. She had an 
appendectomy at age 17. She has no other hospitalizations. She has had no surgeries. 
Her medications include Prenatal Vitamins only. She is allergic to penicillin. She denies 
tobacco, she denies ethanol use, and she denies street drug abuse. Family history 
includes breast cancer in her mother with onset at 38, but is otherwise unremarkable.  

Upon physical exam, the patient will be distraught but cooperative with questioning. 
Cardio-thoracic exam will be unremarkable. Abdominal exam will demonstrate rebound 
tenderness; pain will be focused on the right. Bi-manual pelvic exam will demonstrate 
right adnexal pain and an adnexal mass. Vaginal exam will be otherwise unremarkable.  

Septic 
abortion 

The patient is a 25-year-old woman from a lower socioeconomic group. She presents 
with complaints of lower abdominal pain and fever. She was unable to access a licensed 
abortion care provider and underwent an illegal pregnancy termination two days prior to 
admission. She is not willing to admit this fact unless directly asked whether she had an 
illegal abortion. She will be evasive on all issues involving uterus and pregnancy but will 
be very clear, concise, and thorough on other topics. 

Patient has had vaginal bleeding and generally felt ill for one day. She has had no 
previous pregnancies. She had one admission as a child for a febrile seizure at age 2 
and another admission at age 22 for a motor vehicle accident. She is on no medications. 
She has no known drug allergies. She denies tobacco use, but consumes two or three 
beers on the weekend.  

Von 
Willebrand’s 

disease 

No previous surgeries. No previous hospitalizations. No medications. No known drug 
allergies. No street drug use. There is no history of any bruising. There is not history of 
bleeding with teeth brushing. There is no family history of bleeding disorder. Exam will 
show copious vaginal bleeding originating from the cervix. There is no evidence of 
trauma. 
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Scenario 
Name 

Description 

Post-
operative 

hemorrhage 
status post 
conization 

cervix 

Connie Cox is a 32-year-old patient who underwent conization of the cervix earlier in the 
day. It is now approximately 8:00 in the evening and the patient has presented to the 
emergency room. She was discharged to home in good condition this morning but has 
presented with vaginal bleeding post-operatively. Pathology report is pending. Pre-
operative evaluation included colposcopic directed biopsies of the cervix, which showed 
Cervical Intraepithelial Neoplasia (CIN2); the colposcopy was inadequate at the time. 

The patient has been evaluated by the ER physician and significant vaginal bleeding has 
been reported. 

Learners will be called to the emergency room by the ER physician urgently for this port-
operative patient with ongoing vaginal bleeding. By the time the learners arrive, the 
simulated patient will have lost approximately two liters and will be expected to have 
tachycardia and decreased blood pressure. Urine output has not been assessed. The 
patient is G0. She has had no previous hospitalizations. She is on hydrochlorothiazide 
for blood pressure. She is on no other medications. She is allergic to sulfa. She denies 
tobacco use. She denies street drug use. Exam shows copious blood in vaginal vault. 

Fire in the 
operating 

room 

The patient is a 48-year-old woman who has failed conservative therapy for her 
dysfunctional uterine bleeding. She is Gravida 2 Para 2 with no previous surgeries. She 
was offered multiple surgical options and selected vaginal hysterectomy. She has 
benign essential hypertension and is on a verapamil but is on no other medications and 
has no other medical conditions. She has no drug allergies, is a non-smoker, drinks four 
of five beers a week, and denies drug abuse. Family history is unremarkable. She works 
as a paralegal and lives at home with her husband and 2 teenage sons. 

Physical exam prior to surgery showed an enlarged uterus but was otherwise 
unremarkable.  

Hypoxia in 
the operating 

room 

The patient is a 34-year-old nulligravida patient who is undergoing a scheduled 
myomectomy. She desires conception and was unable to conceive for over 2 years. She 
stopped efforts at conception once the diagnosis of multiple uterine myomata was made. 
Plans have been made to resect these myoma to improve her chances of conception. 
Her past medical history is unremarkable. No previous surgeries have occurred. She is 
currently on oral contraceptive agents. She has no known drug allergies. Social history 
includes a 20-pack year history of smoking. She denies alcohol or drug abuse. Cardiac 
and pulmonary exams are unremarkable upon presentation. 

Cardiac 
arrest in the 

operating 
room 

The patient is a 45-year-old G4P4 patient who is emergently sent to the OR for an 
abdominal hysterectomy due to severe vaginal bleeding. She refused IV estrogen. Her 
blooding became suddenly worse today; previous outpatient work-up included an 
endometrial biopsy, which was benign. No previous surgeries have occurred. 
Medications include hydrochlorothiazide for hypertension and ibuprofen for chronic 
headaches. Social history includes a 40-pack year history of smoking. She denies 
alcohol use or drug abuse. 

Anaphylaxis 
in the 

operating 
room 

The patient is a 20-year-old nulligravida patient who is undergoing a scheduled resection 
of a mature ovarian teratoma (dermoid cyst). The presumed teratoma was discovered 
one month ago at the time of an ultrasound for pelvic pain. The pain has resolved since 
the ultrasound. Her past medical history is unremarkable. No previous surgeries have 
occurred. She is on no current medications. She has no known drug allergies. Social 
history reveals that the patent is a college student. She denies alcohol use or drug 
abuse. 
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Scenario 
Name 

Description 

Malignant 
hyperthermia 

The simulation will begin in the OR with the patient already asleep. The patient is a 35 
year old Gravida 2 Para 2 woman who is undergoing an hysterectomy or other surgery 
as designated by the simulation lab director. For hysterectomy, she had long-term 
dysfunctional uterine bleeding refractory to conservative therapy. She had no previous 
surgeries. Her only hospitalizations were for her two vaginal deliveries. She denied 
smoking and drug abused and consumes approximately two alcoholic beverages a 
week. She is a schoolteacher, married, and lives with her husband and children. Family 
history is unremarkable.  

Physical exam prior to surgery showed a normal cardiopulmonary exam, a 10 week 
sized uterus, no pelvic masses and was otherwise unremarkable. 
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Troubleshooting 

Symptom Possible Cause Solution 

Simulator does not 
power on 

Communication is 
never established 

Data cable is not connected. 

USB communication Module 
is not connected. 

Verify connection of the Ethernet cable and USB module 
to the computer’s USB port. 

Wrong serial number entered 
in the options menu 

From the menu bar, enter the simulator’s serial number 
in the Setup> Options> Environment tab 

Power supply is 
disconnected 

Connect the power supply to the simulator and restart 
the UNI software  

Artificial ventilations 
are not properly 
detected or not 
detected at all 

Respiratory rate is not set to 
zero 

Set the respiratory rate to zero 

Ventilations are not 
calibrated 

See “Calibration Wizard” section on page 20. 

Chest does not rise 
with artificial 
ventilation (e.g. BVM) 

Simulator not running Turn the simulator on 

Respiratory rate is not set to 
zero 

Set the respiratory rate to zero 

Air is escaping between the 
mask and the simulator’s skin 

Maintain a tight seal between the BVM mask and the 
simulator 

Low chest rise (or no 
chest rise at all) while 
breathing  

Respiratory pattern is set to 
apnea 

Change the respiratory pattern to a healthy pattern 

Inspiratory percentage is set 
to a low value 

Set Respiration Rate to 13, and Inspiratory Time to 33% 

Chest compressions 
are not detected 

Heart rhythm is set to sinus Set the heart rhythm to a critical heart rhythm 

Compression sensor is not 
calibrated 

Calibrate the chest compressor using the UNI calibration 
menu on page 21. 

No left radial pulse Radial pulses disabled  Make sure to enable brachial pulse on “Details” tab page 

Blood pressure values are 
require calibration 

To calibrate, go to page to the digital UNI User Guide 
under the software Menu/Help/Instruction Manual.  

Preprogrammed 
scenarios are not 
available 

 Load the “Quick Start Chloe” profile. 
To switch between profiles without exiting the software, 
Click File>Profile on the menu bar. 

The simulator’s 
audible features 
(heart, lung, 
Korotkoff, etc.) are 
low or cannot be 
heard at all 

Audio feature volume is set 
to mute or low 

Adjust the volume levels on the status panel 

Uterine assembly 
veins and arteries do 

The simulator is off Turn on the simulator and enable the bleeding functions 
using the manual UNI controls 
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Symptom Possible Cause Solution 

not fill with blood Fluid reservoirs are empty Turn off the bleeding and refill the artery and vein 
reservoirs with fluid. Re-enable the bleeding and purge if 
necessary. 

Air is trapped in the uterine 
assembly vasculature 

Purge the trapped air in the assembly vein and arteries 
as shown on page 29. 

Palette item is not 
programmed to enable 
bleeding 

Verify that the current or previous palette item enables 
the arterial and venous bleed 

Ruptured ectopic is 
not hemorrhaging  

Bleeding is not enabled Enable the bleeding functions using the UNI controls 

Ruptured ectopic pinch 
clamp is closed 

Open the ectopic pinch clamp and enable the bleeding 
functions using the UNI controls 

Fluid reservoirs are empty Refill the fluid reservoirs with simulated blood 

Vagina does not bleed  Bleeding is not enabled Enable the bleeding functions using the UNI controls 

The Uterine pinch clamp is 
closed 

Open the ectopic pinch clamp and enable the bleeding 
functions using the UNI controls 

Streaming audio 
quality is poor or 
echo  

Headset is disconnected 

Headset connectors are 
connected to the wrong ports 

Headset is not recognized by 
UNI 

Close UNI and connect the MIC and Headphone jacks 
into the designated ports on the laptop. Restart the 
software. 

Headset is not set as default 
input device. 

Close the software and connect the MIC and 
Headphone jacks into the designated ports on the 
laptop. Then, set the headset as the default device on 
the laptop’s audio manager software. (tablet) 

Faulty headset Test using a headset know to work with other equipment 

 Microphone gain is set to 
high 

Lower the gain on the Streaming Voice Control window 

Vital signs are flat 
lined or not updating 

 

PC and virtual monitor are 
not connected to the wireless 
network 

Exit the UNI software and the Gaumard Monitors 
software and connect to the Gaumard network. Restart 
the Gaumard softwares. 

UNI is not broadcasting the 
vital signs information. 
Adapter is set to “loopback”. 

Tablet only - From the Gaumard menu bar, go to 
Monitors>Configuration. Set the adapter to “Wireless 
network connection”. Verify the controller IP and port 
number match the settings on the Gaumard monitor’s 
“Comm Setup” menu. 

ETC Fusion only – Click the gear on the top right, 
Network Settings, Wireless Settings. Verify that “Master” 
is checked and that the Network Name appears on the 
tablet and Gaumard Monitor. 

USB communication module 
is not connected 

Connect the Communication module to the control 
computer and restart the software. 
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Symptom Possible Cause Solution 

Virtual monitor option is not 
activated 

On the menu bar, click Setup>Options> Environment tab 
and set the connection mode to FIXED, then enter the 
simulator’s serial number and save the settings. Return 
to the Options menu and select the “Add-ons” tab. 
Checkmark “Use virtual monitors” and enter the 
activation code. Finally, restart the software. 

 Sensors are off On the UNI menu bar, go to Monitors> Sensors> and 
click “All on” 

Oximeter reading 
does not coincide 
with value set on the 
UNI software 

Monitor sensor is placed on 
the wrong finger 

Place the sensor on the left index finger 

Oxygen saturation feature is 
not calibrated to work with 
the specific device currently 
in use 

Follow the instructions on page 24 to calibrate the 
simulator to work with the oxygen saturation monitor and 
sensor currently in use.  

 

 The simulator can only be calibrated to work with one 
oxygen saturation monitor and sensor at a time. 

Oxygen saturation monitors that detect carbon monoxide 
and/or methemoglobin are not supported. 

Camera is detected in 
the camera setup but 
there is no feed on the 
main window 

Main view distribution is not 
configured 

Click the Main view setup icon and select the active 
video and monitor feeds. 

Events are not listed 
on the PRO+ event 
panel during the 
scenario 

RF Module is not connected Connect the RF module and restart the software 

ETC Fusion is not recording On the UNI menu bar, go click File>New Session to start 
a new scenario 

Dashboard screen is 
unreachable or not 
found 

Virtual monitor PC is not 
connected to the tablet 

From the Virtual monitor PC, connect to the Gaumard 
network. 
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Wireless Network 
Instructions  

 

For Windows 8 and 10 

These first steps of the instructions will apply 
to customers receiving the router as an 
upgrade. If you received the Gaumard 
Monitor computer with the router already 
attached, please proceed to step number 4: 

1. Add Velcro to TPLINK router and 
VM  

 

2. Connect Router to USB power 
supply (Computer can be packaged 
with router connected)  

 

3. Open the Wireless Network 
Connection on the Monitor 
Computer and connect to the 
default network, which name will be 
(GaumardSimulatorSerialNumber)  

a. (example) 
GaumardN0000001 

4. Open the Wireless Network 
Connection on the simulator control 
computer and connect to the same 
network name 
(GaumardN0000001)  

 

CONFIGURE THE VITAL SIGNS 
BROADCAST 

Complete next steps to configure the 
transmission of the vital signs information, 
after the wireless connection is established 
between both computers. 

1. Verify that both computers are 
connected to the GaumardV0000001  
network using Windows® wireless 
connection menu. If the computers are 
not connected, select the network name 
and click “Connect” manually.  

2. Start the UNI control software on the 
control computer 

3. On the UNI menu bar, click the Gear>  
Monitors>Configuration 

4. The simulator “Virtual Monitor Setup” 
window is displayed now 

 

5. Set the adapter to “Wireless network 
connection” or “WiFi” 

6. Verify that the IP Type is set to 
automatic 

7. Write down the “IP Address” and “Port 
number” 

8. Click “Connect” to broadcast an 
outgoing connection 

9. Start the Gaumard Monitors software on 
the virtual monitor PC  
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10. Click the “V” menu near the top left 
corner, and then select “Comm Setup”. 

11. The “Comm Setup” window is displayed. 

12. Click “Show IP” to display the IP 
Address 

 

13. Enter the IP Address from the UNI 
software and verify the port number 

14. Click “Connect” to accept the incoming 
connection 
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Consumable Items and Replacement Parts 
Contact Gaumard Scientific for a complete list of consumables and replacement parts and their prices. 
C=Consumables; R=Replacements; A=Accessories; U=Upgrades; M=Replace in Miami Factory ONLY 

Toll-free in the USA: (800) 882-6655 | Worldwide: 01 (305) 971-3790 | Fax: (305) 667-6085 

Item ID Name Type Description Notes 

S2100.001.R2 A/C Virtual Monitor R A/C Powered touchscreen “All-in-one” computer  

S2100.002 D/C Virtual Monitor R 
D/C Powered 12" Touch Screen Mobile Monitor 
with stylus 

 

S2100.023L.L Lower Left Arm C 
Lower left Osat arm with Osat index finger and 
microphone - re-veining 

Light skin tone 

S2100.023R.L Lower Right Arm C Lower right IV arm skin Light skin tone 

S2100.023L.M Lower Left Arm C 
Lower left Osat arm with Osat index finger and 
microphone - re-veining 

Medium  skin 
tone 

S2100.023R.M Lower Right Arm C Lower right IV arm skin 
Medium  skin 
tone 

S2100.023L.D Lower Left Arm C 
Lower left Osat arm with Osat index finger and 
microphone - re-veining 

Dark skin tone 

S2100.023R.D Lower Right Arm C Lower right IV arm skin Dark skin tone 

S2100.410 Replacement Veins R Replacement Antecubital Veins (latex)  

S2100.081 Silicone Oil R Oil-based Silicone lubricant  

S2100.080 
Simulated Blood 
Concentrate 

C Simulated Blood Concentrate  

S2100.011 Battery Charger R Battery charger with label  

S2100.048 IV Filling Kit R Fluid dispensing syringe with filling tube  

S2100.056  R Blood reservoir cleaning kit  

S2100.060 Simulator Transport Case R Soft storage and transport case with wheels  

S2100.061 Simulator Transport Case A Hard storage and transport case with wheels  

S2100.207 Wired RF Module  R RJ45 Communications Module  

S2100.087  R Streaming voice headset  

S2100.013.D Abdominal Wall Insert C 
Multi-layer design representing the skin, 
subcutaneous, fascia, muscle, and peritoneum 

Dark skin tone 

S2100.013.L Abdominal Wall Insert C 
Multi-layer design representing the skin, 
subcutaneous, fascia, muscle, and peritoneum 

Light skin tone 

S2100.013.M Abdominal Wall Insert C 
Multi-layer design representing the skin, 
subcutaneous, fascia, muscle, and peritoneum 

Medium skin 
tone 

S2100.091  R Abdominal wall insert fasteners and nuts  
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Item ID Name Type Description Notes 

S2100.014.D Uterine Assembly 1 C 

Normal sized uterus including ruptured ectopic 
pregnancy; uterine bleeding; bladder; ovaries; 
fallopian tubes; perineum surface with integrated 
vagina; ovarian and uterine arteries; and round 
ligament, uterosacral ligament infundibulopelvic, 
and cardinal ligament; and peritoneum 

Medium skin 
tone 

S2100.014.L Uterine Assembly 1 C 

Normal sized uterus including ruptured ectopic 
pregnancy; uterine bleeding; bladder; ovaries; 
fallopian tubes; perineum surface with integrated 
vagina; ovarian and uterine arteries; and round 
ligament, uterosacral ligament infundibulopelvic, 
and cardinal ligament; and peritoneum 

Light skin tone 

S2100.014.M Uterine Assembly 1 C 

Normal sized uterus including ruptured ectopic 
pregnancy; uterine bleeding; bladder; ovaries; 
fallopian tubes; perineum surface with integrated 
vagina; ovarian and uterine arteries; and round 
ligament, uterosacral ligament infundibulopelvic, 
and cardinal ligament; and peritoneum 

Medium skin 
tone 

S2100.015.D Uterine Assembly 2 C 

Enlarged sized uterus including ruptured ectopic 
pregnancy; bladder; ovaries; patent  fallopian 
tubes; dermoid cyst; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Medium skin 
tone 

S2100.015.L Uterine Assembly 2 C 

Enlarged sized uterus including ruptured ectopic 
pregnancy; bladder; ovaries; patent  fallopian 
tubes; dermoid cyst; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Light skin tone 

S2100.015.M Uterine Assembly 2 C 

Enlarged sized uterus including ruptured ectopic 
pregnancy; bladder; ovaries; patent  fallopian 
tubes; dermoid cyst; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Medium skin 
tone 

S2100.016.D Uterine Assembly 3 C 

Enlarged sized uterus with embedded fibroids; 
endometrioma; simple cyst; bladder; ovaries; 
patent  fallopian tubes; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Medium skin 
tone 

S2100.016.L Uterine Assembly 3 C 

Enlarged sized uterus with embedded fibroids; 
endometrioma; simple cyst; bladder; ovaries; 
patent  fallopian tubes; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Light skin tone 
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Item ID Name Type Description Notes 

S2100.016.M Uterine Assembly 3 C 

Enlarged sized uterus with embedded fibroids; 
endometrioma; simple cyst; bladder; ovaries; 
patent  fallopian tubes; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Medium skin 
tone 

S2100.017 Bowel Overlay       

S2100.018.D Laparoscopy Wall  C   Dark skin tone 

S2100.018.L Laparoscopy Wall  C   Light skin tone 

S2100.018.M Laparoscopy Wall  C   
Medium skin 
tone 

S2100.EXW 
Two Year Extended 
Warranty 

A Extended warranty for years Two AND Three  

S2100.INST In-Service Training A Day of in-service training and installation  
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Warranty 
EXCLUSIVE ONE-YEAR LIMITED WARRANTY 

Gaumard warrants that if the accompanying Gaumard product proves to be defective in material or workmanship 
within one year from the date on which the product is shipped from Gaumard to the customer, Gaumard will, at 
Gaumard’s option, repair or replace the Gaumard product. 

This limited warranty covers all defects in material and workmanship in the Gaumard product, except: 

1. Damage resulting from accident, misuse, abuse, neglect, or unintended use of the Gaumard product; 

2. Damage resulting from failure to properly maintain the Gaumard product in accordance with Gaumard 
product instructions, including failure to property clean the Gaumard product; and 

3. Damage resulting from a repair or attempted repair of the Gaumard product by anyone other than Gaumard 
or a Gaumard representative. 

This one-year limited warranty is the sole and exclusive warranty provided by Gaumard for the 
accompanying Gaumard product, and Gaumard hereby explicitly disclaims the implied warranties of 
merchantability, satisfactory quality, and fitness for a particular purpose. Except for the limited obligations 

specifically set forth in this one-year limited warranty, Gaumard will not be liable for any direct, indirect, special, 
incidental, or consequential damages, whether based on contract, tort, or any other legal theory regardless of 
whether Gaumard has been advised of the possibilities of such damages. Some jurisdictions do not allow disclaimers 
of implied warranties or the exclusion or limitation of consequential damages, so the above disclaimers and 
exclusions may not apply and the first purchaser may have other legal rights. 

This limited warranty applies only to the first purchaser of the product and is not transferable. Any 

subsequent purchasers or users of the product acquire the product “as is” and this limited warranty does not apply. 

This limited warranty applies only to the products manufactured and produced by Gaumard. This limited 

warranty does not apply to any products provided along with the Gaumard product that are manufactured by third-
parties. For example, third-party products such as computers (desktop, laptop, tablet, or handheld) and monitors 
(standard or touch-screen) are not covered by this limited warranty. Gaumard does not provide any warranty, express 
or implied, with respect to any third-party products. Defects in third-party products are covered exclusively by the 
warranty, if any, provided by the third-party. 

Any waiver or amendment of this warranty must be in writing and signed by an officer of Gaumard. 

In the event of a perceived defect in material or workmanship of the Gaumard product, the first purchaser must: 

1. Contact Gaumard and request authorization to return the Gaumard product. Do NOT return the Gaumard 
product to Gaumard without prior authorization. 

2. Upon receiving authorization from Gaumard, send the Gaumard product along with copies of (1) the original 
bill of sale or receipt and (2) this limited warranty document to Gaumard at 14700 SW 136 Street, Miami, FL, 
33196-5691 USA. 

3. If the necessary repairs to the Gaumard product are covered by this limited warranty, then the first 
purchaser will pay only the incidental expenses associated with the repair, including any shipping, handling, 
and related costs for sending the product to Gaumard and for sending the product back to the first 
purchaser. However, if the repairs are not covered by this limited warranty, then the first purchaser will be 
liable for all repair costs in addition to costs of shipping and handling. 

EXTENDED WARRANTY 

In addition to the standard one year of coverage we offer a range of service plans through our Gaumard Cares 
program. For more information about Gaumard Cares service planes please contact customer service.
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Contact Us 
On the web  

www.Gaumard.com 

Technical Support  

support@gaumard.com 

Sales and Customer Service 

sales@gaumard.com 

Phone: 

Toll-free in the USA: (800) 882-6655 

Worldwide: 01 (305) 971-3790 

Fax: (305) 667-6085 

Before contacting Tech Support you must: 

 Have the simulator’s Serial Number 1.
(located in the left leg under the IM site) 

 Be next to the simulator if 2.
troubleshooting is needed 

Gaumard Scientific  

14700 SW 136 Street 

Miami, FL 33196-5691 USA 

Office hours: Monday-Friday, 8:30am - 
4:30pm EST  

Always dispose of this product and its 
components in compliance with local laws 
and regulations. 

 

The SURGICAL CHLOE simulation system 
is protected by US patens; other Patents 
Pending.  

Gaumard®, CHLOE ®, HAL
®
 are trademarks 

of Gaumard Scientific Company, Inc. 

© Gaumard Scientific Company, 2017. Made 
in U.S.A. All rights reserved. 
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